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FORWARD 

FORWARD 

The concepts, methods, and examples presented in this text are for illustrative and educational 
purposes only, and are not intended to be exhaustive or to apply to any particular engineering 
problem or design. 
 
This material is a compilation of data and figures from many sources. 
 
Engineering Technology Associates, Inc. assumes no liability or responsibility to any person or 
company for direct or indirect damages resulting from the use of any information contained 
herein. 
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INTRODUCTION 

INTRODUCTION 

Welcome to the eta/DYNAFORM version 5.5 Training Manual. The eta/DYNAFORM 
version 5.5 is the unified version of the DYNAFORM-PC and UNIX platforms.  This manual 
is meant to give the user a basic understanding of finite element modeling for forming analysis, 
as well as displaying the forming results. It is by no means an exhaustive study of the simulation 
techniques and capabilities of eta/DYNAFORM. For more detailed study of eta/DYNAFORM, 
the user is urged to attend an eta/DYNAFORM training seminar. 
 
This manual details a step-by-step sheet metal forming simulation process through traditional 
finite element (FE) modeling and the newer QuickSetup interface process. Users should take the 
time to learn both setup processes as each has inherent benefits and limitations.   
 
The traditional setup procedure is extremely flexible and can be used to setup any forming 
simulation. Because the QuickSetup makes certain assumptions as to the type of tooling 
configuration selected it is not as flexible, however, it automates many of the procedures 
required for traditional model setup such as travel curves. 
 
The following table outlines the major differences between the QuickSetup and the traditional 
setup procedure. 
 

TRADITIONAL SETUP QUICK SETUP AUTO SETUP 
Manual interface can duplicate 
any tooling configuration: pads, 
multiple tools, etc. 

Automated interface limits 
flexibility 

There are some inner templates 
that enables user to setup all kinds 
of operation. 

Requires more setup time Reduces modeling setup time Reduces setup time and reduces 
the possibility of make mistake 

Manual definition of travel curves Automated travel curves Automated travel curves and 
manual definition curve 

Geometrical Offset and Contact 
Offset 

Contact Offset Both Contact Offset and 
Geometrical Offset 

 

Note: This manual is intended for the application of all eta/DYNAFORM platforms.  
Platform interfaces may vary slightly due to different operating system requirements. This may 
cause some minor visual discrepancies in the interface screen shots and your version of 
eta/DYNAFORM that should be ignored.
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I. CREATING AN ETA/DYNAFORM DATABASE AND ANALYSIS SETUP 
 
 
Start eta/DYNAFORM 5.5.  
 
For workstation/Linux users, enter the command “df55” (default) from a UNIX shell. 
For PC users, double click the eta/DYNAFORM 5.5 (DF55) icon from the desktop. 
 
After starting eta/DYNAFORM, a default database Untitled.df is created. You will begin by 
importing CAD files to the current database. 
 
Import files 
 

1. From the menu bar, select File Import. to display the Import file dialog window 
illustrated in Figure 1.  

 

  
Figure 1: Import file dialog window 

Click the drop-down button of Files of type to change the file format to “LINE DATA (*.lin)”.  
Go to the training input files located in the CD provided along with the eta/DYNAFORM 
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installation. Locate two data files: die.lin and blank.lin. Then, import both files and select OK 
to dismiss the Import File dialog window. 

 

 
Figure 2: Illustration of S-Rail model 

 
After reading in all of the data files, verify the display looks the same as the illustration shown 
Figure 2. The parts are displayed in the isometric view which is the default view setting of 
eta/DYNAFORM.  

 
Note:  Icons may appear different depending on platform. Other functions on the Icon bar will 

be discussed further in the next section. You can also refer to the eta/DYNAFORM 
User’s Manual for information on all of the Icon bar functions. 
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Figure 3: Save as dialog window 

 
2. Save the database to the designated working directory.  Go to File Save as to open the 

dialog window illustrated in Figure 3. Then, type “dftrain.df” in the File name input field, 
and select Save to dismiss the dialog window. 

 
Analysis Setup 
 
The default unit system of a new eta/DYNAFORM database is mm, Newton, second, and Ton. 
The default setting for draw type is double action (toggle draw).  You may change these 
default settings from the Tools Analysis Setup menu. 
 
Notice: Draw Type corresponds with press type in practice. The parameters define the working 
direction of default punch and die. If you are not sure of operating process, you should select 
User Defined. You can also refer to the eta/DYNAFORM User’s Manual for information on all 
of the Draw Type functions. 
 
File Types 
 
eta/DYNAFORM has the ability to read the following types of input files: 
 
1. Abaqus (*.inp) 8. VDA (*.vda,vdas) 
2. LS-DYNA (*.dyn, *.mod, *.k) 9. DYNAIN file (dynain*, *.din) 
3. NASTRAN (*.nas, *.dat) 10. CATIA v4/v5 (*.model, *.CADPart) 
4. Stereo lithograph  (*.stl) 11. ProE (*.prt, *.asm) 
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5. Autocad (*.dxf) 12. STEP (*.stp) 
6. Line Data (*.lin) 13. Unigraphics  (*.prt) 
7. Iges (*.igs, *.iges) 14. dynain file 
 
 
II. PRACTICE SOME AUXILIARY MENU OPERATIONS 
 
After successfully reading in the needed files to begin the finite element modeling, practice to get 
familiar with some of the basic functions and menus. 
 
View Manipulation 
 

 
 

View Manipulation 

Figure 4: View manipulation 
 

The view manipulation area of the Icon bar (shown in Figure 4) is one of the most visited spots 
in eta/DYNAFORM. These functions enable you to change the orientation of the display area. 
Place the mouse pointer over each icon to display the name and function of each icon. Also, take 
notice of the Display Options area (shown in Figure 5) at the bottom right corner of the screen. 
This is another area enabling you to manipulate the display area.  
 

 
 

Figure 5: Display options dialog 
 
 

The following steps will help you to become more familiar with the functions found in the Icon 
bar, and in the Display Options dialog. 
 

1. Select Isometric from the Icon bar. This places the displayed geometry in an isometric 
view, as shown earlier. The function is shown in Figure 6: 

 

  
 

Figure 6: Isometric icon 
 

2. Rotate the geometry dynamically about the z-axis approximately 90° by using the Rotate 
about Z-Axis function. The function is shown in Figure 7: 
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Figure 7: Rotate about Z-axis icon 
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3. Select Right View (YZ Plane). The result is shown in Figure 8: 

 

 

 
Figure 8: Illustration of model 

 
4. Select Free Rotation to rotate the model. 

 

 
 

Figure 9: Free rotate icon 
 

5. Select Fill Screen from the Icon bar, this makes the displayed geometry fill the screen. 
 

 
 

Figure 10: Fill screen icon 
 

6. Practice using the other viewing options before moving on. 
 
 
III. TURNING PARTS ON/OFF 
 
All geometry in eta/DYNAFORM is arranged based on parts. Every entity, by default, will be 
created or read into a part. You should practice using the On/Off function, located in the Icon 
bar, or in the Parts menu: Parts Turn On. See Figure 11. 
 
 



QUICKSETUP 

 
 

(a) 
 

 
(b) 

 
Figure 11: Part on/off function in (a) Icon bar (b) Menu 

 
1. Notice the Turn On/Off Part dialog box that appears after selecting the Part On/Off button. 
 

 
 

Figure 12: Part turn on/off dialog box 
Place the cursor over different icons and buttons to learn the name of each function. This 
type of selection menu is common in the eta/DYNAFORM environment. It provides several 
different functions for selecting which parts will be turned off or on. 
 

2. Since the part BLANK.LIN contains only line data, you will have to use either the Select by 
Line or the Select by Name function.  

 
3. First, use the Select by Line icon to turn off the part, BLANK.LIN. Click the Select by Line 

icon, and select a line in the part, BLANK.LIN. The part will be turned off. 
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4. Next, use the Select by Name function, and select BLANK.LIN from the list in the dialog 

box.  In the Select by Name field, the parts that are turned on are displayed in their color 
and the parts that are turned off are displayed in white.  

 
5. Before we continue, verify that all available parts are turned on. Select the All On button 

from the Turn On/Off Part dialogue.  
 
6. After you have turned all the parts on, click the OK button on the Turn On/Off Part dialog. 

This will end the current operation. 
 
 
IV. EDITING PARTS IN THE DATABASE 
 
The Edit Part command, illustrated in Figure 13, is used to edit part properties and delete parts.  
 

 
 

Figure 13: Edit part command 
 

 
1. As illustrated in Figure 13, select the Edit function. 
 

The Edit Part dialog box shown in Figure 14 will be displayed, with a list of all the parts 
that are defined in the database. The parts are listed with the part name and identification 
number. From here, you can modify the part name, ID number and part color. You can also 
delete parts from the database. 
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Figure 14: Edit part dialog box                         Figure 15: Select color dialog box 
 

2. Select the part DIE.S from the part list. Change its color by clicking on the Color button and 
selecting a new color from the palette illustrated in Figure 15. 

            
3. Select the part DIE.S from the part list. Change the Name by inputting LOWTOOL in the 

field as shown below. 
 

              
 

Figure 16: Editing part name and color 
 
4. Once you have entered the new name (LOWTOOL) and selected the desired part color, 

click on the Modify button located at the bottom left of the dialog to complete the changes. 
 
5. Click Close to end this operation. 
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6. Save your database. 
 
Note: Designers often model only one surface of upper or lower die. The other die face will offset from 

the mating surface. In this case, we suppose the surface is the lower tool. Hence,  We choose the 
part name as LOWTOOL. The upper tool will offset from the surface.  

 
 
V. CURRENT PART  
 
All lines, surfaces, and elements which were created will automatically be placed into the current 
part. When creating new lines, surfaces, or elements, always make sure the desired part is set as 
current.   
 
Note: When auto-meshing surfaces, the user does have the option of assigning the created mesh to the 

parts that contain the individual surface data. In other words, you can keep the mesh in the 
original parts, rather than have them all created in the current part. This will be dealt with later 
on. 

 
1. To change the current part, click on the Current Part icon in the Display Options dialog 

illustrated in Figure 17.  
 

 
 

Figure 17: Current part icon 
 

Or select Parts Current on Menu bar 
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Figure 18: Current part function 
 
 

2. The Current Part dialog box will be displayed. 
 



QUICKSETUP 

 
 

Figure 19: Part turn on/off dialog box 
 

 
3. Similar to the Part Turn On/Off dialog box, you may select the current part in different 

ways. Place the cursor over each icon to identify its function.  
 
4. Set the part BLANK.LI as current by selecting the part name from the Select by Name list 

that is displayed. 
 
5. Practice setting the current part.  
 
6. Turn off all of the parts except BLANK.LI, and set it as current. 
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MESHING 

 
Meshing from surface or line data is a very important step contributing to a successful simulation. 
There are many methods of creating mesh, however in this exercise, the Blank Generator and 
Surface Mesh will be used to generate meshes. 
 
 
I. BLANK MESHING 
 
Blank meshing is the most important mesh function since the accuracy of the forming results 
depends heavily upon the quality of blank mesh. There is a special function for blank meshing. 
 
 
1. Select Tools Blank Generator on Menu bar, as illustrated in Figure 20. 
 

 
 

Figure 20: Tools menu 
 

 
2. Select the BOUNDARY LINE option from the Select Option dialog box illustrated in 

Figure 21. 
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Figure 21: Select option dialog box 
 

 
3. The Select Line dialog box shown in Figure 22 is displayed. 
 

 
 

Figure 22: Select line dialog box 
 

 
The BLANK.LI part consists of 4 line segments.  Select the lines one-by-one by first 
placing your mouse cursor on each one of them, following by clicking on left mouse button. 
The Select Line dialog box allows you to select the line(s) in different ways. Place the cursor 
over each icon and button to identify its function. 
 

4. Select OK after selecting all four lines. 
 
5. Use the default variable (6.0) for the concerned tool radii.  This number reflects the tightest 

concerned die radii in the model. The smaller the radii, the finer the blank mesh; a larger 
value will result in coarser mesh. 
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Figure 23: Concerned tool radius 
 
6. After you have entered the variable, press OK. A Dynaform Question dialog box pops up 

askign you to accept, deny or remesh the mesh. Press Yes to accept the mesh. 
 

 
 

Figure 24: Dynaform Question dialog box 
 

 
If you have entered an incorrect value, click on the ReMesh button to correct the concerned tool 
radii value and accept the mesh, or No to cancel it and repeat the above steps to re-mesh. 
 
7. Compare your mesh with the picture shown in Figure 25. 
 
8. Save the database. 
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Figure 25: Blank mesh 

 
 
 
II. MESHING SURFACE DATA 
 
Most of the meshing done in eta/DYNAFORM is carried out using the Surface Mesh function. 
This function will automatically create a mesh based on the provided surface data. It provides a 
very quick and easy way of meshing the tools. 
 
1. Turn off the part BLANK.LI and turn on the part LOWTOOL. Set the part LOWTOOL as 

current. 
 
2. Select Preprocess Elements on Menu bar. 
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Figure 26: Preprocess menu 
 

 
3. Select Surface Mesh from the Element dialog box shown in Figure 27. 
 

 
 

Figure 27: Element dialog box 
 

 
4. In the displayed Surface Mesh dialog box (shown in Figure 28), default values in all fields 

will be used. Toggle off the In Original Part and Boundary Check options. 
 
Note: Chordal deviation controls the number of elements along the line/surface curvature; 

Angle controls the feature line 
Gap Tol. controls whether two adjacent surfaces are connected. 
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Figure 28: Surface mesh dialog box                      Figure 29: Select surface dialog box 
   
 

5. Choose the Select Surfaces button from Surface Mesh dialog.  
 
6. From the Select Surface dialog shown in Figure 29, choose the Displayed Surf icon. 

 
Notice all of the displayed surfaces will turn white. This verifies they have been selected. The 
Select Surface dialog box allows you to select the surface(s) in different ways. Place the 
cursor over each icon and button to identify its function. 

 

16                                                         eta/DYNAFORM Training Manual 



MESHING 

7.  Click Apply button on the Surface Mesh dialog box.  
 
8. The mesh will be created and will be displayed in white. To accept the mesh, click the Yes 

button when prompted, “Accept Mesh?” in the Surface Mesh dialog box. Compare your 
mesh with the mesh displayed in Figure 30. 

 

 
 

Figure 30: Tool mesh 
 
 

9. Press Exit on the Surface Mesh dialog box to exit the function. 
 
Now that we have all the parts meshed, you can turn off the surfaces and lines by turning off 
Surfaces and Lines in the Display Options dialog. This makes it easier to view the mesh.  
 
10. Save your database. 
 
 
 
 
III. MESH CHECKING 
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As the mesh has been created, its quality has to be checked to verify that there aren’t any defects 
that could cause potential problems in the stamping simulation.  

 



QUICKSETUP 

 
All the utilities used for checking the mesh are located under the Preprocess Model 
Check/Repair on the Menu bar. 

 

 
 

Figure 31: Preprocess menu 

 
 

As shown in Figure 31, the Model Check/Repair menu consists of several functions that enable 
you to check the quality of mesh. Only two of the functions are described in this training manual. 
Please refer to eta/DNAFORM Online Help for information regarding to the remaining 
functions. 
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Figure 32: Mesh check & repair dialog box 

 

 

Auto Plate Normal  
 
1. Select Auto Plate Normal from the Model Check/Repair dialog box shown in Figure 32. A 

new dialog will be displayed. 
 

2. The displayed dialog prompts you to pick an element to check all the active parts or an 
individual part for element normal consistency. Select an element on the part LOWTOOL, 
as highlighted in Figure 33. 
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Figure 33: Reference element for normal direction of elements 

 
3. An arrow will be displayed showing the normal direction of the selected element. From the 

pop up dialog box, click Yes to accept the normal direction.  
 

 
 

Figure 34: Dynaform Question dialog box 
 

 
Pressing Yes will check all elements in the part and reorient as needed to the direction that is 
displayed. Pressing No will check all elements and reorient as needed to the opposite 
direction.  
 
In other words, press Yes if you want the normal to point in the direction of the displayed 
arrow, or No if you want it to be the opposite direction. The normal direction of all elements 
in a part has to be consistent. If some elements’ normal is pointing upward, while some 
pointing downward, eta/DYNAFORM will create inferior elements during element offset 
operation. 
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Note: In this case, we will offset upper tool from the lower tool by the normal direction. Therefore, 

select Yes to make sure the normal to point in the direction of the displayed arrow. 
 

4. Now that the LOWTOOL elements are consistent, check the rest of the parts in the database. 
Turn off all the parts and turn each one at a time. Check the normal direction and make sure it 
is consistent.  
 

5. Once all the normal directions are consistent, turn on all of the parts and save the changes. 
 

Display Model Boundary  
 
This function checks any gaps or holes of the part, and highlight them so you can manually 
correct the problems. 
 
1. Select Display Model Boundary from the Model Check & Repair dialog box. 

  
2. Minor gaps in the tool mesh are acceptable. Blank mesh should not contain any gaps unless       

the blank is lanced or is designed with gaps. Select the isometric view and make sure that 
your display resembles Figure 35. 

 
 

Figure 33: Display model boundary 
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3. Turn off all of the elements and nodes from the Display Options dialog (Note: the boundary 

lines are still displayed). This allows you to inspect any small gaps that might be difficult to 
locate when the mesh is displayed. The results are shown in Figure 36. 

 
Figure 36: Model boundary after hidden nodes and elements 

 
4. Check for overlapping elements and minimum element size. Delete the duplicate elements if 

there were found. 
 
5. Turn only the part LOWTOOL on and click the Clear icon (as shown in Figure 37) on the 

Icon bar to remove the boundary lines. 
 

 
 

Figure 37: Clear icon 
 
6. Save your database. 
 
 
IV. QUICKSETUP VS. TRADITIONAL SETUP 
 
In eta/DYNAFORM, you can set up the stamping simulation model using either QuickSetup or 
Traditional setup. Save the changes of your initial database to a unique name, such as 
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“original_mesh.df”. We will use the database later on to setup stamping simulation model using 
Traditional setup.  
 
Now, use the Save As function to save the database under a different name, for example, 
“dftraining_qs.df”. We will use this database to proceed with setup of stamping simulation 
using QuickSetup. The new database name and directory path should be displayed in the upper 
left corner of the eta/DYNAFORM interface. 
 
This manual will first detail the QuickSetup process, then the Traditional setup. Proceed to the 
Traditional setup section (page 68) in this manual if you are already familiar with the QuickSetup 
interface and analysis setup procedure. 
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Prior to entering the QuickSetup interface, you need to separate the binder run-out (lower ring) 
from the lower tool. This will allow the QuickSetup to automatically offset the upper binder from 
this run-out. This procedure is common to all QuickSetup models that require a binder. 
 
 
I. DEFINE THE LOWER RING FROM THE LOWER TOOL 
 
Next step is to separate the Lower Ring from the LOWTOOL, and move elements on run-out 
of LOWTOOL into Lower Ring. 
 
 
1. Turn on LOWTOOL and turn off all other parts. 
 
2. Create a new part called LOWRING. This part will keep the elements separated from the 

LOWTOOL. Click Parts Create on Menu bar. See Figure 38. 
 

 
 

Figure 38: Preprocess menu 
 
 

3. Enter LOWRING at the input field of Name in the Create Part dialog box illustrated in 
Figure 39. Click OK to create the part. 
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Figure 39: Create part dialog box 
 

 
4. The part LOWRING has been created and set as the current part automatically. You can 

now place the lower ring elements in this part. 
 
5. Click on Parts Add… To Part on Menu bar. See Figure 40. 
 

 
 

Figure 40: Preprocess menu 
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6. The Add…To Part dialog box shown in Figure 41 is displayed. Click the Element(s) button 

to display the Select Elements dialog box shown in Figure 42. 
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Figure 41: Add…To Part dialog box 
 

 
 

Figure 42: Select elements dialog box 
 
7. The easiest way to select all elements of the ring is to switch the view to the YX plane using 

the Top View icon on the Icon bar. Then, select the Spread icon shown in Figure 42, 
following by pressing and holding left mouse button on the Angle Slider. Move your mouse 
to drag the slider. Since the ring surface is flat, you may set 1º as the spread angle. 

 
8. Now, use your mouse cursor to pick the element (as illustrated in Figure 43) on the lower 

right corner of LOWTOOL.  
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Figure 43: Selecting corner element 
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All elements in the flat area before an element angle change of larger than 1º should be 
highlighted. Compare your display to Figure 43. If your results differ, repeat the above steps. 
 
9. Use your mouse cursor to pick the element on lower left corner of LOWTOOL. 
 
10. Select OK on the Select Elements dialog box. You will find the number of elements (67) is 

shown on the left side of the Element(s) button as below, as indicated in Figure 44.  
 
11. Select the Unspecified button to display the Part Turn On/Off dialog box shown in Figure 

45. 
  

 
Figure 44: Indicating selected elements 
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12. Select LOWRING in the Select by Name list. The program changes the Unspecified button 
to LOWRING. 

 

 
Figure 45: Part turn on/off dialog box 

 
13. The Apply button is enabled, as shown in Figure 46. Click Apply button to move all 

selected elements into LOWRING. 
 

 
 

Figure 46: Add…To Part dialog box 
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14. Hit the Top View icon in the Icon bar. Then, use the Part Turn On/Off function to display  
the LOWRING illustrated in Figure 47. If display on your screen differs, repeat the above 
steps. 

 

 
Figure 47: Illustration of binder surface 

 
15. Save your database. 
 
 
II. QUICKSETUP INTERFACE 
 
1. Select Setup Draw Die illustrated in Figure 48 to display the QuickSetup GUI. 
 

 
 

Figure 48: Setup menu 
 



QUICKSETUP 

 
Figure 49: QuickSetup GUI 

2. As shown in Figure 49, the undefined tools are highlighted in red in the QuickSetup GUI. 
Firstly, you need to select the Draw Type and Type of Available tool. In this application, the 
draw type is “Single action” or Inverted draw, while the lower tool is selected as the 
available tool. 

 
3. Define the blank and tools by clicking the corresponding buttons. 
 
 
III. DEFINE TOOLS 
 
The parts LOWTOOL and LOWRING are meshed and can be defined as the Binder and Lower 
Tool, respectively. 
 
To define the Binder: 
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1. Click the Binder button, following by selecting the SELECT PART function from the 

Define Tool dialog box illustrated in Figure 50. 
 
2. Next, click on the Add button in the Define Binder dialog box shown in Figure 51. 
 
3. Use your mouse cursor to pick the part LOWRING from the Select Part dialog box 

illustrated in Figure 52. 
 
4. Click OK button in the Select Part dialog box to confirm part selection. 
 
5. Again, click OK button to dismiss the Define Binder dialog box. 
 
6. Click EXIT button to quit the Define Tool dialog box.  
 
7. Repeat the above steps to define the Lower Tool. Once both tools are defined, the color in 

the Quick Setup/Draw window will be changed to green, as illustrated in Figure 53. 
 

 
Figure 50: Define tool dialog box 

 
 

Figure 51: Define binder dialog box 
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Figure 52: Select part dialog box 
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Figure 53: QuickSetup GUI after tools are defined 
 
 
IV. DEFINING THE BLANK MATERIAL 
 
1. Click the Blank button from QuickSetup GUI. 
 
2. Then, select the SELECT PART function from the DEFINE BLANK dialog box.  
 
3. Click “Add” button to pick the BLANK from the part list in Select Part dialog box. 
 
4. Click OK button in the Select Part dialog box to confirm part selection. 
 
5. Click EXIT button to quit the DEFINE BLANK dialog box. 
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6. Next, you need to define the material and thickness. You may enter the blank thickness value 
in the input data field of Thickness. In this case, you select the default value of 1.0 (mm). 

 
7. From the Blank Parameters field, click None button to assign the blank material. From the 

Material dialog box, click the Material Library button to display the generic material library 
illustrated in Figure 54. 

 
Select the Mild Steel “DQSK” under material type 36 (Note: material type 36 and 37 are 
recommended for most simulations). 

 

 
 

Figure 54: Generic material library window 
 
8. Select OK to use the default material parameters (illustrated in Figure 55) for the DQSK 

material model (Disclaimer: ETA does not guarantee validity or accuracy of the generic 
material models in the material library. You should contact the original material suppliers to 
determine appropriate material parameters). To complete the material definition, select OK 
from the material window and return to the QuickSetup interface.  

 
9. Save your database. 
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Figure 55: Material type 36 window 
 
The following are the description of other functions in the QuickSetup interface: 
 

• Auto Assign enables you to quickly assign parts with conventional names as tooling. 
For example, if the blank part name is named “BLANK”, the part “BLANK” will be 
defined as the model BLANK after you click the Auto Assign button.  “DIE” and 
“BINDER” are the other tooling names recognized by  Auto Assign function in 
QuickSetup interface. Drawbeads are not recognized by the Auto Assign function. 

• Constraint allows you to define SPC (single point constraint) for symmetry or other 
boundary conditions. 

• Advanced allows you to change default parameters related to QuickSetup. 
• Apply automatically copy all defined tooling with its mating tool, in addition to 

assigning the travel curves. 
• Reset deletes all mating tools and travel curves “resetting” the database to the state it 

was before the apply button was selected. 
• Preview allows you to animate tool movement and check the tooling travel curves. 
• Submit job initiates the analysis menu. 
• Exit is utilized to exit the QuickSetup interface. 
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Figure 56: QuickSetup GUI after tools and blank are defined 
 
10. Now, select Apply illustrated in Figure 56. The QuickSetup will automatically create mating 

tools, position the tools and generate the corresponding travel/force curves. Both Preview 
and Submit Job function are activated. 

 
11. Select Preview to check the tooling movement. 
 
12. Compare your display with the illustration in Figure 57. 
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Figure 57: Illustration of model setup after autopositioning 
 
 
V. RUNNING THE ANALYSIS 
 
After verifying the tool motion, you can define the final control parameters and proceed to run 
the analysis. 
 
1. Click Submit Job button to display the “Analysis” dialog box shown in Figure 58. 

eta/DYNAFORM Training Manual                                                         37 
 



QUICKSETUP 

 
 

Figure 58: Analysis dialog box 
 

 
2. Click the Control Parameters button in the Analysis dialog box to display the DYNA3D 

CONTROL PARAMETERS dialog box illustrated in Figure 59. 
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Figure 59: DYNA3D control parameters dialog box 
 
You are recommended to accept the default control parameters. For detailed information about 
each control parameters, please refer to the LS-DYNA User’s Manual. 
 
4. Click OK button to accept the default control parameters. 
 
5. By default, the Adaptive Mesh option is checked. Adaptive mesh allows you to refine the 

coarse elements into smaller elements to capture detailed tool geometry.  
 
6. Click Adaptive Parameters button to display the ADAPTIVE CONTROL 

PARAMETERS dialog box illustrated in Figure 60.  Set the LEVEL (MAXLVL) as 3. 
This means that the mesh will be split twice if needed. Higher levels of adaptivity will result 
in better accuracy but require longer processing time. Since this is a simple part, adaptive 
level 3 will be sufficient. The default values will be used for other parameters. Click OK 
button to accept the default setting.  

 

 
 

Figure 60: Adaptive control parameters dialog box 
 

 
7. To submit the job, click the drop down button of Analysis Type to select Full Run Dyna (as 

shown in Figure 61). Next, toggle on “Specify Memory” checkbox and key in 120 (Mb). 
Then, click OK button to initiate the solver. 
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Figure 61: Analysis dialog box 
 
The solver displays a DOS window (illustrated in Figure 62) showing the status of the 
in-progress simulation. You notice an estimated completion time is given. This time is not 
accurate due to implementation of adaptivity option. However, it does give you a general idea.  
 
Proceed to page 97 for post-processing after the program is completed. 
 

40                                                         eta/DYNAFORM Training Manual 



QUICKSETUP 

 
 

Figure 62: LS-DYNA solver window 
 
The status of in-progress stamping simulation can be determined by using the sense switch. The 
user can press the Ctrl + C key to interrupt the in-progress simulation. This operation will 
momentarily pause the solver and prompt the user to input the sense switch code at “.enter sense 
switch:” line. There are nine terminal sense switch codes provided in LS-DYNA. The common 
sense switch codes are listed below: 

 
sw1 – A restart file is written and solver terminates.  

sw2 – Solver responds with estimated time and cycle numbers. 

sw3 – Creates a d3dump restart file and solver continues 

sw4 – Creates a d3plot file and solver continues. 

 

Note: These switches are case sensitive and must be all lower case when entered. For 
information about other sense switch codes, refer to LS-DYNA User’s Manual. 

 
Type in sw2 and press Enter. Notice the estimated time has changed. You can use these switches 
anytime while the solver is running.  

 
When you submit a job from eta/DYNAFORM, an input deck is automatically created. The input 
deck is adopted by the solver, LS-DYNA, to process the stamping simulation. The default input 

eta/DYNAFORM Training Manual                                                         41 
 



QUICKSETUP 

deck names are yourdatabasename.dyn and yourdatabasename.mod. In addition, an index file 
named yourdatabasename.idx is generated for the reference in eta/POST. The .dyn file contains 
all of the keyword control cards, while the .mod file contains the geometry data and boundary 
conditions. Advanced users are encouraged to study the .dyn input file. For more information, 
refer to the LS-DYNA User’s Manual. 
 
Note: All files generated by either eta/DYNAFORM or LS-DYNA is stored in the directory in 

which the eta/DYNAFORM database has been saved. You shall ensure the folder doesn’t 
include similar files prior to running the current job because these files will be 
overwritten. 

 

 
 

Figure 63: Sense switch 

Again, the eta/DYNAFORM Quick Setup interface is designed to help you to quickly setup a 
standard drawing simulation. You are encouraged to learn the traditional setup described in the 
following section. 
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AUTO SETUP 

Open the saved database as described in meshing section of this manual (on page 23) 
dftraining_as.df.  This file should contain the clean mesh data of the LOWTOOL layer . If you 
do not have this database, repeat the procedure in MESHING section. 

 

Prior to entering the AUTOSETUP interface, you only need mesh tools. Other operations are 
carried out in AUTOSETUP interface, such as PHYSICAL OFFSET of element, selection of 
CONTACT OFFSET. You can select AUTOSETUP option in the SETUP menu (shown in 
Figure 64) to display the interface. 

 
Figure 64: Setup menu 

I. NEW SIMULATION 

After you select the AutoSetup option, the New Simulation dialog box illustrated in Figure 65 is 
displayed. 

 
Figure 65: New simulation dialog box 
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b) Select process type: Single Action. 

c) Input blank thickness: 1.0 (mm).  

d) Select tools reference: BOTTOM. 

e) Click OK to display the main AUTOSETUP dialog box. 

 

 
Top surface of part 

 
Middle surface of part 

 
Bottom surface of part 
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Different surface referred by Die and Punch 

Figure 66: Reference blank surfaces 

 

II. GENERAL 
After entering General definition page, modify the Title to Df_training_01 (as illustrated in 
Figure 67), while keeping other default parameters. 
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Figure 67: General definition page 

III. BLANK DEFINITION 
 

1．Click the Blank tab to enter the Blank definition page.  

2．Click Parts… button from Geometry field in Blank definition page (shown in Figure 
68). 

 
Figure 68: Geometry field 

3.  The program will pop up the Define Geometry dialog box shown in Figure 69. 
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Figure 69: Define geometry dialog box 

 

4.  Click Add Part… button to display the Select Part dialog box. Use your mouse cursor to 
pick the BLANK part in the dialog box (shown in Figure 70).    

 
Figure 70: Select Part dialog box 

5.  After selecting the part, click OK button to exit the dialog box. The program returns the 
Define Geometry dialog box. The BLANK part is added to the list of Define Geometry 
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dialog illustrated in Figure 71. 

 
Figure 71: Define geometry dialog box 

 
6. Exit the dialog box to return to the Blank definition page. Now, the tag color of the Blank 

is changed red into black, indicating the blank part is assigned. See Figure 72. 
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Figure 72: Blank definition page 

 

IV. TOOLS DEFINITION 
 

1. Click the Tools tab to enter the Tools definition page. 

2. Click  icon in the Icon bar to display the Part Turn On/Off dialog box, following 
by turning off the BLANK part. 

3. AUTOSETUP displays three standard tools: die, punch and binder located at the left of 
Tools definition page.  

4. From die interface illustrated in Figure 73, select Parts… button to assign a part as die. 
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Figure 73: Tool definition page 

 

5. The Define Geometry dialog box illustrated in Figure 74 is displayed. Click the Add 
Part… button. 

 

 
Figure 74: Define geometry dialog box 

 

6. Select LOWTOOL part in the Select Part dialog box illustrated in Figure 75. 

 

7. Click OK to return to Define Geometry dialog box. The LOWTOOL part is now 
added to the list of die, as illustrated in Figure 76. 

 

8. Click EXIT button to return to Tools definition page. You notice the tag color of die is 
changed from red to black, as illustrated in Figure 77. 
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Figure 75: Select part dialog box 
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Figure 76: Define geometry dialog box 
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Figure 77: Tools definition page 
 

9. Click punch located at the left side of tools list to display punch definition page. See 
Figure 77. 

 
10. Click Parts… button in the punch definition page to display the Define Geometry 

dialog box. 
 
11. Click Copy Elem… button in the Define Geometry dialog box. 
 
12. The Copy Elements dialog box illustrated in Figure 79 is displayed. Then, click Select… 

button to display the Select Elements dialog box. 

 
Figure 78: Define geometry dialog box 

 

13. Select elements for punch from the current database. AUTOSETUP will copy these 
elements into a default part, and automatically add the part to the list of punch. 

 

14. Click DISPLAYED button to select all elements in the Select Elements dialog box. Now, 
the program indicates 784 elements have been selected. See Figure 80.  



AUTO SETUP 
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Figure 79: Copy elements dialog box 

  

Figure 80: Select elements dialog box 

15. Next, you need to remove elements on the flanges of the part. Toggle on EXCLUDE 
option (shown in Figure 81). Then, click the Surface icon in the Select Elements dialog 
box.  
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Figure 81: Select elements dialog box 

16. Select two sides of the flanges. As shown in Figure 82, the highlighted elements is copied 
as punch.  

 
Figure 82: Highlighted elements for punch 
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17. The program indicates you have selected 721 elements as punch. 

18. Click OK button to confirm the selection. The program returns to Copy Elements dialog 
box. Now, the APPLY button is activated. See Figure 83. 

 

  

Figure 83: Copy elements dialog box 

19. Click Apply button, to copy the elements into a new part.  

 

Figure 84: Create punch 

20. Click Exit button to dismiss the Copy Elements dialog box. Now, a new part named 
OFFSET00 is added to the list of tools geometry. See Figure 85. 
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Figure 85: Define geometry dialog box 

21. Click Exit button to return to the Tools definition page illustrated in Figure 86. The tag 
color of punch is changed from red into black indicating the punch has been defined.  

 
Figure 86: Punch definition page 

 
22. Click binder located at the left side of tools interface to enter the binder definition page. 

Then, click Parts… button to display the Define Geometry dialog box.  
 
23. Click Copy Elem… button to display the Copy Elements dialog box. Next, click 

Select… button to select elements on the flanges. 
 

24. Select the flange in the two sides of tool by way of selecting surface. The program 
indicates 72 elements have been selected. See Figure 87. 

 
25. Exit the Select Elements dialog box. Click Apply button to copy elements in the Copy 

Elements dialog box. All selected elements will be automatically copied to a new part, 
and the program will add the part to the list of binder. Then, click Exit button.  

 
26. Click Exit to return the main Tools definition page. The tag color of all tools has been 

changed red into black, indicating all tools have been defined. 
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Figure 87: Select elements dialog box 

 

 
Figure 88: Highlighted elements as binder 
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Figure 89: Define geometry dialog box 

 

V. TOOL POSITIONING 
 

After defining all tools, the user needs to position the relative position of tools for the stamping 
operation. The tool positioning operation must be carried out each time the user sets up a 
stamping simulation model. Otherwise, the user may not obtain correct stamping simulation 
setup.  

 

The tool position is related to the working direction of each tool. Therefore, you need to carefully 
check the working direction prior to positioning the tools. If the process template is chosen, the 
default working direction is selected. You can also define special working direction. 

 

1. Click Positioning… button located at the lower right corner of tools interface to 
display the Positioning dialog box illustrated in Figure 90. Alternatively, you may 
select Tools->Positioning… on the menu bar to display the dialog box. 



AUTO SETUP 

 
Figure 90: Positioning dialog box 

 
2. Select punch as fixed tool and use it as the referenced tool in positioning operation. 
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3. Click Auto button to automatically position all tools and blanks. 

 
4. Now, all tools and blank(s) are moved to a preset position. The value behind every 

tools is the distance from the home position to the current position. See Figure 91. 
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Figure 91: After positioning 

 

5. Toggle off the Lines and Surfaces option in the Display Options located at the 
lower right corner of screen. See Figure 92. 

 

 
Figure 92: Display options 

 

6. Click  and  icon in the Icon bar to display the model after positioning. 
See Figure 93. 
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Figure 93: Model after autopositioning 

 

7. Click OK button to save the current position of tools, and returns to the main 
interface. 

 
 

VI. PROCESS DEFINITION 
 

The Process definition is utilized to set up process parameters of the current simulation such as 
time required for every process, tooling speed, binder force and so on. The parameters listed in 
process definition interface depend on the pre-selected process template, including type of 
simulation and process.  

 

In this example, the type of simulation and process is Sheet Forming and Single Action, 
respectively. Therefore, two default processes are listed in the process definition interface: 
closing and drawing process. 

 

You can press Process tab of the main interface to enter process definition interface. Next, 
follow the steps listed below:  

 

1. Select closing process from the list located at left side of the interface as the current 
process. See Figure 94.  

2. Verify the default setting of closing stage is similar to Figure 94.  

3. Select drawing process from the list located at left side of the interface as the current 
process. See Figure 95. 

4. Verify the default setting of drawing stage is similar to Figure 95.  
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Figure 94: Closing process interface 
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Figure 95: Drawing process interface 

 

VII. ANIMATION 
 

Prior to submitting a simulation job, you shall validate the process setting by viewing the 
animation of tool movement. The procedure to conduct animation is listed as the following: 

 

1.  Select Preview->Animation… in the menu bar. 
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Figure 96: Animation menu 
 

2.  The animation of tool movement is shown on the display area.  

3.  You can select the INDIVIDUAL FRAMES option from the ANIMATE dialog box 
illustrated in Figure 97 to display the incremental tool movement. 

 

 
Figure 97: Animate dialog box 

 

3． Click  icon to display the condition step by step. 
 
4．The time step and displacement of tools are printed on the upper left hand corner of the 

display area. See Figure 98. 
 

5．Click Exit to return the main interface. 
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Figure 98: Animating review 

 

 
VIII. SUBMIT JOB  
 

After validating the tools movement, you may continue with submitting the stamping simulation 
through the steps listed below: 

 

1.  Click Job->Job Submitter… in the menu bar. 

 
Figure 99: Job menu 

 

2.  The Submit Job dialog box illustrated in Figure 100 is displayed.  
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Figure 100: Submit job dialog box 

 

3.  Click Submit button to submit job. 

 

 
Figure 101: Job Submitter interface 

 

4.  Click Submit Jobs button, as shown in Figure 101 to activate the LS-DYNA solver for 
running the stamping simulation. The LS-DYNA window illustrated in Figure 102 is 
displayed and the simulation is in progress. 
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Figure 102: LS-DYNA solver window 
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TRADITIONAL SETUP 

 
Open the saved database as described in meshing section of this manual (on page 22).  This file 
should contain the clean mesh data of the lower tool before it was separated for the QuickSetup 
procedure. If you do not have this database, repeat the procedure of MESHING. 
 
 
I. OFFSETTING THE LOWER TOOL MESH TO CREATE THE UPPER 

TOOL 
 
1. Create a new part called UPTOOL. This part will keep the elements offset from the 

LOWTOOL. Click Parts Create on Menu bar. 
 
 

2. In the New Part dialog box, enter “UPTOOL” in the name field. Click OK button to create 
the part. 

 

 
 

Figure 103: Create part dialog box 
 
The part UPTOOL has been created and set as the current part automatically. You can now 
offset elements into this part. Turn on LOWTOOL and turn off BLANK.LI. 
 

3. Select Preprocess Elements on the Menu bar.  
 

 

Figure 104: Preprocess menu 
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4.  Select the Copy Elements icon from the Element dialog box illustrated in Figure 105. 
 

           
Figure 105: Element dialog box                Figure 106: Copy elements dialog box 

 
 
5. Click the drop-down menu to the right side Type, and select Offset. See Figure 106. 

 
6. Toggle off In Original Part so that the offset elements will be put in the current part. Make 

sure UPTOOL is set as current. Toggle off Delete Original Part, the original part will be 
kept. 

 
7. Enter 1 in the Copy Number field as the number of copies. Enter 1.1 (mm) in the Thick 

field as the offset thickness. In eta/DYNAFORM, the offset thickness is based on the 
material thickness of the blank plus 10% tolerance.  

 
8. Click Select Element button.  
 
9. Select Elements dialog is displayed. Click the Displayed button illustrated in Figure 107. 

You notice that the selected elements are highlighted in white. 
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Figure 107: Select elements dialog box 
 
10. Click OK to accept the selected elements and return to the Copy Elements dialog box. 
 
11. Click on Apply button. All offset elements are placed into the part UPTOOL. Check your 

display by clicking the Left View icon. See Figure 108. 
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Figure 108: Model 

 
 

12. If your results differ, select Undo. Repeat the above steps to create mesh of UPTOOL.  
 
13. Turn off the part LOWTOOL so that only UPTOOL is displayed. Switch to the isometric 

view.  
 
14. Save your database. 
 
 
II. CREATE THE LOWER RING  
 
Now, you will separate the Lower Ring from the LOWTOOL and move elements on Run-out 
of LOWTOOL into Lower Ring. 
 
1. Turn on LOWTOOL and turn off all other parts. 
 
2. Create a new part called LOWRING. This part will hold the elements that we separate from 

the LOWTOOL. Click Parts Create on Menu bar. 
 
3. Enter LOWRING in the name field. Click OK and the part will be created.  
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Figure 109: Create part dialog box 
 

 
4. The part LOWRING has been created and set as the current part automatically. You place 

the lower ring elements in this part. 
 
5. Click on Parts  Add…To Part from Menu bar. 
 
6. The Add…To Part window appears as follows. Click the Element(s) button as shown 

below. 
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Figure 110: Add…To Part dialog box          Figure 111: Select elements dialog box 
 
7. The Select Elements window appears (as shown above). The easiest way to select all 

elements of the ring is to switch the view to the Top View (YX plane). Then, select the 
Spread icon. Click the slider and drag it to set an angle. Since the ring surface is flat, set a 
small angle, such as 1 degree. 

 
8. Click any element on the right ring of LOWTOOL. 
 
9. Click any element on the left-ring of LOWTOOL. 
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Figure 112: Highlighted elements 

 
All elements in the flat area before an element angle change of larger than 1 degree should 
be highlighted. Compare your display to the preceding image. If your results differ, repeat 
the above steps. 
 

10. Select OK on the Select Elements window. You will find the number of elements (67) is 
shown on the left side of the Element(s) button as below.  

 
11. Select the Unspecified button. 
 

 
Figure 113: Add…To Part dialog box 
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12. The Select Part window shows up. Select LOWRING in the Select by Name list. At this 

time, the Unspecified button will change to LOWRING. 
 
13. Click Apply, all selected elements are moved into LOWRING.  
 
14. Turn on only LOWRING and display the part using Isometric view, the resulting display 

should be as the following. If the result differs, please repeat the above steps. 
 

 
Figure 114: Illustration of binder 

 
15. Save the database. 
 
 
III. SEPARATE LOWRING AND LOWTOOL 
 
Now LOWRING and LOWTOOL have two different groups of elements but they share 
common nodes along the boundaries. We need to separate them so that LOWRING and 
LOWTOOL can move independently. 
 
 Let’s turn on LOWRING and LOWTOOL and turn off other parts. 
 
1. Click Parts Separate on the Menu bar. 
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Figure 115: Separate function 
 
2. The Select Part window appears. Select LOWTOOL and LOWRING in the Select by 

Name list. Click OK to finish the function. 
 
3. Save the changes. 
 
 
 
IV. DRAW TYPE SETUP 
 
Prior to defining the tools, we first setup the draw type. 
 
Click Tools Analysis Setup from Menu bar. Select the Single Action as the Draw Type. 
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Figure 116: Analysis setup dialog box 
 
The Draw Type should correspond to the type of machine used to produce the actual work piece. 
This parameter defines the default moving direction of the punch and binders. If you are not sure, 
or are performing a new process, you should select User Defined. You can also refer to the 
eta/DYNAFORM User’s Manual for information on the draw type. 
 
 
V. TOOL DEFINITION 
 
Defining Parts as Tools 
 
The parts BLANK.LI, LOWTOOL, UPTOOL, and LOWRING are all meshed and can now 
be defined as tools.  
 
1. Select Tools Define Tools on Menu bar.  
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Figure 117: Define tools dialog box 
 

2. In the Define Tools dialogue, select DIE from the Tool Name menu as below.  
 
3. Select ADD. 

 
4. The Select Part dialogue will be displayed, prompting you to select which part will be 

defined as the DIE. Choose UPTOOL from the Select by Name list and then click OK. 
 
5. Return to the Define Tools dialogue. You will find the UPTOOL is placed in the Include 

Parts List. 
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Figure 118: Define tools dialog box 
 
6. Repeat the above steps to define the Punch (LOWTOOL) and Binder (LOWRING). 

Remember to select the correct Tool Name in Step 2. 
 
7. Once you have all of the tools defined, click OK on the bottom of Define Tools dialogue to 

finish this step. Save the changes. 
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VI. DEFINING THE BLANK AND SETTING UP PROCESSING 
PARAMETERS 

 
 
Define the Blank 
 
1. Select Tools Define Blank on the Menu bar. 
 

        
 

Figure 119: Define blank dialog box 
 
2. Click the Add button in the Define Blank dialog box. 

    
3. The Select Parts dialogue is displayed. Select BLANK.LI from the Select by Name list.  
 
4. Click OK. The BLANK.LI is added to the Include Part List as shown below. 
 
 
Define the Blank Material  
 
1. The Define Blank dialogue should still be opened, click the button located right next to 

“material:” 
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Figure 120: Define blank dialog box                Figure 121: Material dialog box 
 

 
2. Select Material Library. A list of materials will be shown as in the illustration below. In this 

dialogue, select the mild steel “DQSK” under material type 36 (Note: material type 36 and 
37 are recommended for most simulations). 
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Figure 122: Generic material library window 
 
3. Select OK to use the default material parameters (following image) for the DQSK material 

model (Note: ETA makes no guarantees as to the validity and/or accuracy of the generic 
material models from the material library. Users should contact their material suppliers to 
determine proper material parameters). 

 
 
Define Blank Property 
 
1. The Define Blank dialog box remains, click the button just right of where it says Property:  

(This button will say None because the property has not been defined yet).   
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Figure 123: Define blank dialog box          Figure 124: Property dialog box 
 

 
2. In the Property dialogue, enter a name for the material, For example put “blankpro” for 

material property. (If there is a default property name exists, user can skip the typing). Be 
sure to select type BELYTSCHKO-TSAY (default) and select any color from Color 
dialogue. Click New.  

 
3. The BELYTSCHKO-TSAY Property card will be displayed. In this dialogue, you can edit 

the thickness of the material. To edit a field, left click on the field and change the value in the 
Current Value dialogue. Make sure UNIFORM THICKNESS is 1.000. Leave all other 
fields at their default values and select OK. 

 

 
 

Figure 125: Belytschko-tsay dialog box 
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4. eta/DYNAFORM returns to the Property dialogue. Click OK. 
 
5. Select OK to finish defining the Blank, Material and Property. 
 

 
 

Figure 126: Define blank dialog box 
 
 
VII. TOOLS SUMMARY 
 
1. Verify that all of the needed tools are defined by selecting the Tools Summary function in 

the Tools menu. 
 
2. After you have verified the tooling definition, click OK. Save the changes. 

 

84                                                         eta/DYNAFORM Training Manual 



TRADITIONAL SETUP 

 
 

Figure 127: Tool list dialog box 
 
 
 
VIII. AUTO POSITIONING THE TOOLS 
 
Now that all of the tools have been defined, we need to place them in the correct position by 
doing the following: 
 
1. Turn on all of the parts in the database and select the isometric view. 
 
2. Click Tools Position Tools Auto Position on the Menu bar. 

 

 
Figure 128: Position tools menu 

 
3. The Auto Position Tools dialogue will be displayed. In this dialogue, define the Master and 

Slave Tools. The Master Tool is the tool that will not move while you Auto Position; it should 
be the Blank. Select BLANK in the Select Master Tool dialogue and then select the 
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remaining tools in the Select Slave Tools dialogue. (For the PC version, the user needs to 
hold down the control key to select all three slave tools).  

 

         
 

Figure 129: Autoposition tools dialog box 
 
Once the correct Master and Slave Tools are selected, be sure that Z (direction) is selected as the 
moving direction and enter a Contact Gap of 1.  The gap value should be the Blank Thickness 
to avoid initial penetration. Press Apply and the tools will be automatically positioned. 
 
4. Compare your display with the following image. 
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Figure 130: Illustration of model 

 
5. If your result differs, select UNDO to repeat the above steps and make sure the result is 

correct. If the position is wrong, check Tools/Analysis Setup, make sure the “Draw type” is 
set to inverted. 

 
6. Select CLOSE to exit the auto position menu. 
 
7. Save the changes. 
 
 
IX. MEASURING THE DIE TRAVEL DISTANCE 
 
Now that the parts have been meshed and defined as tools, we can setup the motion curves. The 
first step is to find the travel distance of the tools. 
 
1. Click Tools Position Tools Min Distance on Menu bar. 
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Figure 131: Min. Distance function 
 

2. The Min. Distance dialogue will be displayed. Select Z (direction) as the direction to 
measure in, then highlight the DIE, following by the PUNCH. This will allow user to 
measure the distance, in the Z-direction, between the Punch and the Die, and display it in the 
Distance dialogue. 
 

 
Figure 132: Min. Dis between tools dialog box 
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3. The total distance between the Punch and the Die is approximately 42. To find the Punch 

travel distance, subtract the offset thickness (blank thickness + 10%). We will obtain a Punch 
travel distance of approximately 40.9. Take note of the number you calculated. 

 
4. Select OK located at the bottom of the Min. Distance dialogue, and end this step. 
 
The automatic distance measurement is reliable for flat binders. For more complicated binder 
shapes, the user should measure the travel distance using the distance measurement tool between 
nodes found under the Utilities menu. 
 
 
X. DEFINE DIE VELOCITY CURVE 
 
1. Click Tools Define Tools on the Menu bar. 
 
2. Select Die from the Tool Name list and then select the Define Load Curve button. 
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Toggle the Z 
button on to 
free the Z 
direction travel 

 
        Figure 133: Define tools dialog box                        Figure 134: Tool load curve dialog box 

 
 

3. Click on Auto. Make sure the Z is selected as the Degrees-of-Freedom to define the moving 
direction. Use the default curve type (Motion) (see the following illustration). 
                   

4. Choose Velocity as the default Curve Type (see illustration below) and default Curve Shape 
as Trapezoidal. Keep the beginning time of 0.000E+000. In the Velocity field, enter 8000 
(mm/s). For the Stroke Dist., use the value that we found after measuring the Punch travel 
distance and subtracting the Blank thickness. The value should be approximately 40.9. After 
entering the values, click Yes and a new Velocity vs. Distance motion curve will be created 
and displayed (as shown in the following illustration). 
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      Figure 135: Motion curve dialog box 
 

5. Verify that the load curve is identical to the graph as shown on next page. 
 

 
 

Figure 136: Plotting motion curve 
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6. Select Ok in the Curves dialogue to return to the Tool Load Curve dialogue. From here, 

click Ok once more to return to the Define Tools dialogue. Do not close this dialogue, the 
next step will start from here. 

 
 
XI. DEFINING THE BINDER (LOWRING) FORCE CURVE 
 
As the Punch travel curve has been created, we can create the force curve for the Lower Ring. 
 
1. From the Define Tools dialogue, select Binder from the Tool Name menu and select the 

Define Load Curve button. 
 

                  
        Figure 137: Define tools dialog box                   Figure 138: Tool load curve dialog box 
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2. Select Curve Type (Force).  Make sure to select Z to define the moving direction and then 
click Auto button. 

 
3. Enter 200000 (N) in the FORCE and close the window by clicking OK. 

 

 
 

Figure 139: Force/time curve dialog box 
 
4. The Lower Ring force curve will be displayed. Verify that it is identical to the curve shown 

on next page. 
 

 
 

Figure 140: Plotting binder force 
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5. Select OK in the Curves dialogue to return to the Tool Load Curve dialogue. From here, 
select OK once more to return to the Define Tools dialogue.  

 
6. Click OK in the Define Tools dialogue; we are done defining the motion curves for the tools. 
 
7. Save the changes. 
 
 
XII. PREVIEW TOOL ANIMATION 
 
We have now completed all of the pre-processing outside of setting up the final simulation 
parameters and submitting the job. Before we can do that however, we should verify that the 
tools are moving correctly, based on the motion curve information we have assigned.  
 
1. Click Tools Animate on Menu bar. 

 

                    
 

Figure 141: Define animation dialog box 
 
2. Click Play to animate the tooling using the default parameters.  

 
Note: Depending on the speed of the machine that is used to run eta/DYNAFORM, the animation 

might move too quickly. If this is the case, enter a larger number of frames. 
 
3. You can change the view while running the preview animation. Verify that the Punch is 

moving in the Z-direction, and make sure it is moving the full distance into the Die. Since we 
are using a force curve for the Binder, you will not see it move. Also, notice the Individual 
Frames switch on the dialogue. After viewing the animation, click the Stop button on the 
Animate dialogue to exit the function. 
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Figure 142: Animate dialog box 
 
4. Save the database. 
 
 
XIII. RUNNING THE ANALYSIS 
 
After verifying that the tool motion is correct, we can define the final parameters and run the 
analysis. 
 
Running the Analysis with Adaptive Mesh 
 
Adaptive mesh allows the user to obtain more accurate results by refining the blank mesh as 
needed during the simulation. In other words, as the die deforms the blank, areas that demand a 
finer mesh to capture the tooling geometry will divide to create finer and smaller elements.  
 
1. Select Analysis LS-DYNA… from the Menu Bar. 

 

 
 

Figure 143: Analysis menu 
 
2. Click the Control Parameters button in the Analysis Parameters dialogue. 
 
3. As a new user, it is recommended to use the default control parameters (for more information 

on them, please refer to the LS-DYNA User’s Manual). Click OK. 
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Figure 144: DYNA3D control parameters dialog box 
 
4. There are two methods to run the job.  
 

1. Select Full Run Dyna and press OK. The solver will now be running in the background. 
 

2. For manual submission of the input deck: 
a.  Select LS-Dyna Input File and enter a file name (e.g. training) and press Ok. 

  
b. Find the directory that includes your current example file (training.df), you will find 

two files “training.dyn” and “training.mod”. All files generated by either 
eta/DYNAFORM or LS-DYNA will be placed in the directory in which the 
eta/DYNAFORM database has been saved. This includes all input decks and post 
processing files. 

 
c. Then select File->Submit Dyna from Input Deck, find the “training.dyn”, then press 

OK. 
 

d. Give a right memory, press OK to start the solver. 
 
The solver displays a DOS window showing the status of the job. You will notice that an 
estimated completion time is given. This time is not accurate since we are using adaptive mesh 
and the model will re-mesh several times. Also, it is influenced the speed and number of CPU of 
the machine. However, it does give you a general idea. 
 
5. Once the solver has given you the preliminary estimated time, you can refresh this estimate 

by pressing Ctrl-C. This will momentarily pause the solver which will prompt you to “.enter 
sense switch:”. Type the switch command you would like to use and press enter: 
 
sw1 – Terminates the Solver  

sw2 – Refreshes the Estimated Solving Time 

sw3 – Creates a d3dump Restart File 

sw4 – Creates a d3plot File 
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Note: These switches are case sensitive and must be all lower case when entered. 
 
Enter sw2 and press Enter. Notice the estimated time has changed. You can use these 
switches at anytime while the solver is running.  

 
 

Figure 145: Sense switch 
 

When you submit a job from eta/DYNAFORM, an input deck is created which the solver, 
LS-DYNA, uses to process the analysis. The default input deck names are yourdatabase 
name.dyn and yourdatabasename.mod. The .dyn file contains all of the control cards, and 
the .mod file contains the geometry data. Advanced users are encouraged to study the .dyn input 
file. For more information, refer to the LS-DYNA User’s Manual).  
 

Note: All files generated by either eta/DYNAFORM or LS-DYNA will be placed in the 
directory in which the eta/DYNAFORM database has been saved. It is necessary to make 
sure the fold doesn’t include other resultant files before running the current job in case part 
of files are overwritten. 
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POST PROCESSING (with eta/POST) 

The eta/POST reads and processes all the available data in the d3plot file. In addition to the 
undeformed model data, the d3plot file also contains all result data generated by LS-DYNA 
(stress, strain, time history data, deformation, etc.).  
 

I. Reading the Results File into the Post Processor 

To execute eta/POST, click PostProcess from eta/DYNAFORM menu bar illustrated in Figure 
146. The default path for eta/POST is C:\Program Files\Dynaform 5.5. In this directory, you can 
double click on the executable file, EtaPostProcessor.exe to open eta/POST GUI illustrated in 
Figure147. The eta/POST can also be accessed from the programs listing under the start menu of 
DYNAFORM 5.5. 

 

Figure 146:  Post process menu  

  
Figure 147: eta/POST GUI 

1. From the File menu of eta/POST, select Open function. The Open File dialog box 
illustrated in Figure 148 is displayed. 

98                                                         eta/DYNAFORM Training Manual 



POST PROCESSING (with eta/POST) 

 
2. The default File Type is LS-DYNA Post (d3plot, d3drlf, dynain). This option enables you 

to read in the d3plot, d3drlf or dynain file. The d3plot is output from forming simulation, 
such as drawing, binder wrap and springback, while d3drlf is generated during gravity 
loading simulation. The dynain is generated at the end of each simulation. This file contains 
the deformed blank information. 

 
Note: Please refer to eta/POST User’s Manual for description about other file types. 

 
3. Choose the directory of the result files. Pick the metalforming_.d3plot file illustrated in 

Figure 148, and press Open button.  
 
4. The d3plot file is now completely read in. You are ready to process the results using the 

Special icon bar, as shown Figure149. 
 

 
 

Figure 148:  Open file dialog box 

         
Figure149:  Special icon bar for forming analysis 
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II. Animating Deformation 

1. The default Plot State is Deformation. In the Frame dialog, select All Frames and 
press Play button to animate the results. See Figure 150. 

        
Figure 150:  Animating deformation dialog box 

2. Toggle on the Shade checkbox in the display options illustrated in Figure 151. The Smooth 
Shade option is also toggled on by default to enable smooth and continuous model display. 

 
Figure 151:  Display options 

3. Since it is difficult to see the Blank with all of the other tools displayed, you can hide all of 

the tools by pressing the  icon from Icon bar. 
4. In Part Operation dialog, use your mouse cursor to click on all the parts, excluding BLANK, 

as illustrated in Figure 152. All the tools are hidden form the display area. Then, press Exit 
button to dismiss the dialog box. 
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Figure 152: Part turn on/off dialog box 
 

5. You can also change the displayed model using the view manipulation icons on the Icon bar 
illustrated in Figure 153. 

 
Figure 153:  Icon bar 

III. Animating Deformation, Thickness and FLD 

In eta/POST, you can animate deformation, thickness, FLD and various strain/stress distribution 
of the blank. Refer to the following examples for animation. 
 
Thickness/Thinning 
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1. Select  icon from the Special icon bar.  

2. Select Current Component from combo box, either THICKNESS or THINNING. The 
thickness contour of deformed dome is illustrated in Figure 154. 

3. Click Play button to animate the thickness contour. 

4. Use your mouse cursor to move the slider to set the desired frame speed. 

5. Click Stop button to stop the animation.  

 
Figure 154: Thickness/Thinning contour 

 
FLD 

1. Pick  from the Special icon bar.  

2. Select Middle from the Current Component list, as illustrated in Figure 155. The FLD 
contour of deformed dome is illustrated in Figure 156. 

3. Set FLD parameters (n, t, r, etc.) by clicking on the FLD Curve Option button to display the 
FLD CURVE AND OPTION dialog box. 

4. Click OK button to dismiss the FLD CURVE AND OPTION dialog box. 
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5. Select Edit FLD Window function to define location of FLD plot on the display window. 

6. Click Play button to animate the FLD contour of deformed dome. 

7. Click Stop button. 

 

 
Figure 155: FLD display dialog box 
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Figure 156: FLD contour 

 

IV. Plotting Single Frames 

Sometimes, it is much convenient to analyze the result by viewing single frames rather than the 
animation. To view single frame, select Single Frame option from the Frames combo box 
illustrated in Figure157. Then, use your mouse cursor to select the desired frame from the frame 
list. You can also drag the slider of frame number to select the frame accordingly. 

 



POST PROCESSING (with eta/POST) 

  
Figure 157:  Display of single frame 

 
 

V. Writing an AVI and E3D File 

eta/POST provides a very useful tool that allows you to automatically create an AVI movie 
and/or E3D files via an animation of screen capture. The Record button illustrated in Figure 158 
is commonly utilized to generate AVI movie and/or E3D files. This is the last function covered in 
this application example. 
 
AVI movie 
The following procedure is used to generate an AVI movie file. 

1. Start a new animation using the procedure provided in Section III.  

2. Display the model in isometric view. 

3. Click the Record button. 

4. The Select File dialog is displayed.  

5. Enter a name of the AVI move file (e.g. traincase.avi) at the input data field of File Name 
illustrated in Figure159. 

6. Then, click Save button. 
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8. eta/POST will take a screen capture of the animation and write the output. 

 
Figure 158:  AVI dialog box 

 
Figure 159:  Save AVI file 
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Figure 160:  Select compression format 

E3D file 

You can also  save simulation results in a much compact file format (*.e3d). The *.e3d file can 
be viewed using eta/3DPlayer which is provided as a free software to any users.  

 

To create an E3D file, refer to the steps listed below: 

1. Start a new animation (thickness, FLD, etc) using the procedure provided in Section III.  

2. Display the model in isometric view. 

3. Click the Record button. 

4. The Select File dialog box is displayed. 

5. Click the drop-down button of File Type to select E3D Player file (*.e3d). 

6. Enter a name of the E3D file (e.g. traincase.e3d) at the input data field of File Name. 

7. Then, click Save button.  

8. eta/POST will take a screen capture of the animation and write the output into *.e3d format. 

 

You can view 3D simulation results using the player. To start the player, select Start All 
Programs Dynaform 5.5 Eta3DPlayer. 
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MORE ABOUT DYNAFORM 5.5 

 
Inside the eta/DYNAFORM 5.5 installation directory, there is a file called .DyanformDefault. 
Many key default parameters are included in this file. Advanced users can customize these 
default parameters. 
 
For Unix/Linux users, the .DynaformDefault file is located under both the installation directory 
and the user’s home directory.  The .DynaformDefault file located under the installation 
directory will take precedence over the one located in the user home directory. 
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CONCLUSION 

 
This concludes the training guide’s basic overview of eta/DYNAFORM 5.5. This manual is 
meant to give the user a basic understanding of finite element modeling for forming analysis, as 
well as displaying the forming results. It is by no means an exhaustive study of the simulation 
techniques and capabilities of eta/DYNAFORM. For more detailed study of eta/DYNAFORM, 
the user is urged to attend a eta/DYNAFORM training seminar. 
 
Please refer to the eta/DYNAFORM and the LS-DYNA User’s Manuals for detailed discription 
of individual functions and analysis settings. 
 

 
eta/DYNAFORM team 
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